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WARNING 
 
 
To ensure the equipment described by this User Manual, as well as the equipment connected to 
and used with it, operates satisfactorily and safely, all applicable local and national codes that 
apply to installing and operating the equipment must be followed. This includes the National 
Electric Code in the USA and other applicable legislation, regulations, and codes in practice 
elsewhere. Since codes can vary geographically and can change with time, it is the user’s 
responsibility to determine which standards and codes apply, and to comply with them. 
 
FAILURE TO COMPLY WITH APPLICABLE CODES AND STANDARDS CAN RESULT IN 
DAMAGE TO EQUIPMENT AND/OR SERIOUS INJURY TO PERSONNEL. 
 
Persons supervising and performing installation or maintenance must be suitably qualified and 
competent in these duties, and should carefully study this User Manual and any other manuals 
referred to by it prior to installation and/or operation of the equipment. 
 
 
The contents of the User Manual are believed to be correct at the time of printing; however, no 
responsibility is assumed for inaccuracies. In the interests of a commitment to a policy of 
continuous development and improvement, the manufacturer reserves the right to change the 
specification of the product or it’s performance or the contents of the User Manual without notice. 
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SECTION 1  
GENERAL DESCRIPTION 

This section describes the features of the HSM-WI7 Standun 
Bodymaker High Speed Logic module. This includes the functional 
description, alarms detected, interlocks between the module and the 
existing control system, etc. 
 
________________________________________________________ 
1.1 FEATURES 
 

Performs the high-speed control functions of Standun Bodymaker 
to speeds in excess of 500 CPM. This includes clutch control, 
cupfeed control, air strip control, as well as die protection (short 
can detection). 

• 

• 

• 

• 

• 

• 

• 

• 

 
Rapid response control of clutch/brake system for emergency 
stops die protection) as well as precise BDC stops. The clutch 
solenoid outputs of the HSM-WI7 are not intended as safety 
contacts for the bodymaker clutch and must not be the only 
interrupt to the clutch solenoids. 

 
Accurate short can detection to a resolution of 1/4” can length. 

 
Highly repeatable air strip control to reduce can stripping and 
blow out problems. 

 
Reliable timed cupfeed control to insure proper cup loading and 
protection from misloads. 

 
Brake Wear compensation (Auto BDC timing programming) 
algorithm to stop press at BDC regardless of brake response. 
Brake response determination allows displaying of actual brake 
response (in degrees). Brake response alarm to indicate when 
brake-stopping response (in degrees) has exceeded user preset 
limit. 

 
Trimmer speed reference (0-10volt analog output) provides 
reference to trimmer proportional to speed of bodymaker (user 
scalable). 

 
Alarm detection: short can detection, die sensor fail alarm, timing 
signal fail detection, clutch output failure detection, no ram 
motion alarm, resolver failure detection, and brake response too 
long alarm. 
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Data Acquisition: Total number of good cans produced and total 
number of short can faults (for both current shift and last shift). 

• 

• 

• 

• 

• 

 
Built-in 2 Line X 40 character sealed display with 24 key 
membrane keypad allows local viewing of collected data (good 
can count, short can count, brake response) by operator and set-up 
of all user variables (passcode protected or key switch enabled) by 
authorized personnel. 

 
Interfaces directly with the machine-mounted resolver, short can 
sensor and all clutch, cupfeed, and air strip solenoids. 

 
Based on the high performance M4503 PLC/PLS module that 
allows easy trouble-shooting and user customization using 
SYSdev (DOS-based) programming package. 

 
Built-in PLS provides all machine timing, eliminating need for  an 
additional PLS. 

 
 
________________________________________________________ 
1.2 FUNCTIONAL DESCRIPTION 
 
The HSM-WI7 bodymaker high-speed logic module is an electronic 
upgrade for the Standun bodymaker that performs the high-speed 
control functions of the bodymaker including: rapid response 
clutch/brake control, accurate short can detection, reliable cupfeed 
and precise air strip control. In addition, the package provides a brake 
wear compensation feature, which automatically adjusts the BDC 
timing signal to stop the press at BDC regardless of brake stopping 
time. 
 
Alarm detection is provided including:  

• Short Can Detection 
• Die Sensor Failure Detection 
• Timing Signal Failure 
• Clutch Output Failure Detection 
• No Ram Motion Alarm 
• Resolver Failure Detection 
• Brake Response Too Long Alarm 
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Data collection includes (both for the current shift and previous (last) 
shift):  

• Total Good Can Count 
• Short Can Faults Count 

 
The package interfaces directly to:  

• The Machine Mounted Resolver 
• Short Can Sensor 
• Clutch/Brake 
• Cupfeed and Air Strip Solenoids 
• Host PLC via Discrete DC I/O. 

 
The package is not a dedicated “black box”, but is instead 
implemented using the high performance SYSTEMS M4503 
PLC/PLS module, which allows easy customization by either SEA or 
the end user. The M4503 module is programmed using the DOS-
based SYSdev programming package, which allows the module to be 
programmed in any combination of Ladder or High-level (subset of 
“C”), as well as perform on-line monitoring and trouble-shooting. The 
M4503 module incorporates a built-in PLS which interfaces directly 
with the machine-mounted resolver and provides all machine timing, 
eliminating the need for an external PLS. 
 
 
________________________________________________________ 
1.3 CLUTCH/BRAKE CONTROL 
 
The clutch/brake solenoids are activated by the HSM-WI7 through 
the electro-mechanical two-hand control circuitry provided externally 
by the user. The throughput of the HSM-WI7 is 0.5 milliseconds. The 
fast throughput along with the fact that the PLS is fully integrated into 
the HSM-WI7, allows extremely fast and repeatable de-clutching and 
braking response to be achieved. Normally the clutch is controlled via 
inputs on the HSM-WI7 that are controlled from outputs on the host 
PLC. However, detection of any of the alarms (short can fault, die 
sensor failure, etc.) results in an immediate de-clutch of the solenoids.  
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________________________________________________________ 
1.3.1 CONTROL OF CLUTCH VIA HOST PLC 
 
Six discrete DC inputs to the HSM-WI7 from the host PLC are used 
to control the clutch: “Clutch On No.1”, “Clutch On No.2”, 
“Continuous Mode”, “Single Mode”, “Inch/Bar Mode”, and “Not 
Immediate Stop”. The HSM-WI7 is essential a high speed gate which 
implements the BDC stop, sequenced stops closing the cupfeed, 
single, inch, and bar clutch control all based the states of the six 
inputs listed above. The following description of operation defines the 
requirements of the host PLC logic to activate the clutch through the 
HSM-WI7: 
 
Continuous Mode: 
 
1) To activate the clutch in continuous mode, turn both the “Clutch 

On No.1” and “Clutch On No.2” inputs “on” simultaneously 
while the “Continuous Mode” and “Not Immediate Stop” inputs 
are “on”. The “Single” and “Inch/Bar” inputs must be  “off”. 

 
 2) To perform a BDC stop, turn both the “Clutch On No.1” and 

“Clutch On No.2” inputs “off” while leaving the “Not Immediate 
Stop” input “on”. 

 
 3) To perform an immediate (emergency) stop, turn both the “Clutch 

On No.1” and “Clutch On No.2” as well as the “Not Immediate 
Stop” inputs “off” simultaneously. The “Not Immediate Stop” 
input is used to indicate to the HSM- WI7 that the clutch should 
be disengaged immediately, not waiting for the BDC timing 
signal. 

 
Single Mode: 
 
1) To single stroke the press, with the “Single Mode” and “Not 

Immediate Stop” inputs “on”, turn the “Clutch On No.1” and 
“Clutch On No.2” inputs “on” simultaneously for 5 to 50 
milliseconds. The press will make one stroke. Both the 
“Continuous” and “Inch/Bar” mode inputs must be “off”. 
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Inch Mode: 
 
1) To inch the press, with the “Inch/Bar” mode and “Not Immediate 

Stop” inputs “on”, simultaneously turn “on” and “off” both the 
“Clutch On No.1” and “Clutch On No.2” inputs. The clutch is 
activated as long as both inputs are “on”. Both the “Continuous” 
and “Single” mode inputs must be “off”. 

 
Bar Mode: 
 
1) With both the “Inch/Bar Mode” and “Not Immediate Stop” inputs 

“on”, the clutch can be activated by simultaneously turning both 
the “Clutch On No.1” and “Clutch On No.2”inputs “on”. The 
clutch is activated as long as both inputs are “on”. Both the 
“Continuous” and “Single” mode inputs must be “off”. 

 
Note:  In all the above modes, the “Clutch On No.1” and “Clutch On 
No.2” inputs must be turned “on” simultaneously (within 0.5 seconds) 
in order for the clutch to activate. 
 
Refer to the schematic at the back of this manual for typical HSM-
WI7 clutch connections. 
 
 

________________________________________________________________________________ 
 
IMPORTANT SAFETY WARNING - The HSM-WI7 is intended as a high-speed logic 
gate to provide consistent and accurate clutch control. It is not designed as a 
redundant, dual-processor clutch brake safety module. The HSM-WI7 must not be 
the only means of controlling the bodymaker clutch mechanism. Good design 
practice dictates the use of safety interlocks on any device that starts or stops 
automatically that can cause personnel injury to operating or maintenance 
personnel. The HSM-WI7 must be used only in conjunction with industry approved 
safety interlock contacts, implemented in accordance with ANSI B11.1 safety 
requirements; otherwise, serious personnel injury may result. 
 
________________________________________________________________________________ 
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________________________________________________________ 
1.4 CUPFEED/ROTARY FEED TRIP SOLENOID CONTROL 
 
The HSM-WI7 package provides control for both the cupfeed and 
rotary trip solenoids. Both are enabled by the host PLC via individual 
inputs to the HSM-WI7. The cupfeed is timed “on” and “off” with the 
cupfeed timing signal of the HSM-WI7 PLS section to provide 
accurate cup loading. The rotary trip solenoid is activated “on” and 
“off” by the host PLC but is immediately de-activated automatically 
by the HSM-WI7 at the detection of a short can. 
 
 
________________________________________________________
1.4.1 CONTROL OF CUPFEED SOLENOID VIA HOST PLC 
 
A discrete DC input to the HSM-WI7 from the host PLC is used to 
control the cupfeed solenoid: “Cupfeed On”. The following logic to 
activate the cupfeed through the HSM-WI7: 
 
Cont/Single Mode: 
 
1) In single and continuous modes, the cupfeed is gated “on” with 

the leading edge of the cupfeed timing signal (CH04) and gated 
“off” with the trailing edge of the cupfeed timing signal (CH04). 
The cupfeed is opened when the “Cupfeed On” input is turned 
“on” and the leading edge of CH04 occurs. The cupfeed is closed 
when the “Cupfeed On” input is turned “off” and the trailing edge 
of CH04 occurs. 

 
Note: It takes two strokes once the cupfeed is opened for the first 
can to travel through the rotary cupfeed and punched. Once the 
cupfeed is closed, it requires two strokes to punch the last two 
cups, which are in process of traveling through the rotary cupfeed.  

 
Inch Mode: 
 
1) When the “Inch Mode” input is “on”, the cupfeed is controlled 

directly by the “Cupfeed On” input. When the “Cupfeed On” 
input is “on”, the cupfeed is open. When the “Cupfeed On” input 
is “off”, the cupfeed is closed. 
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________________________________________________________
1.4.2 CONTROL OF ROTARY TRIP SOLENOID 
 
A discrete DC input to the HSM-WI7 from the host PLC is used to 
control the cupfeed solenoid: “Rotary Enable”. The rotary trip 
solenoid is controlled directly by the “Rotary Enable” input. When 
the input is “on”, the rotary cam is engaged. When the input is “off”, 
the rotary cam is disengaged. In addition, the rotary cam is 
automatically disengaged when a short can is detected. 
 
 
________________________________________________________
1.5 AIR STRIP CONTROL 
 
The HSM-WI7 provides a repeatability of 0.5 milliseconds for the air 
strip thus reducing can stripping and blow out problems. Both an “Air  
Strip (Low)” and “Air Strip (High)” timing signal is provided to 
activate the air strip when the press is running in low and high speed 
respectively. The air strip is enabled when the cupfeed is opened. 
 
 
________________________________________________________
1.6 BRAKE WEAR COMPENSATION 
 
The HSM-WI7 incorporates a brake wear compensation or automatic 
BDC timing feature that stops the press at BDC regardless of the 
actual braking response of the clutch/brake.  The stopping sensation is 
accomplished by automatically adjusting the BDC timing signal based 
on the previous stop.  Any overrun is detected and a new BDC timing 
signal is computed such that the machine will stop at the desired 
location on the next stop. Two BDC signals are provided: one for low 
speed and one for high speed. Both incorporate the break wear 
compensation feature. The appropriate BDC timing signal (low or 
high) is adjusted based on the speed of the machine when the BDC 
stop was initiated. 
 
In addition to the brake wear compensation, the HSM-WI7 also 
calculates the actual brake response (in degrees). This is the number 
of degrees from where the clutch was de-activated (BDC timing 
location) to where the crankshaft actually ended up stopping. This can 
then be displayed by the operator or maintenance personnel to 
determine the condition of the brake. 
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A “Brake Response Too Long” alarm is also generated when the 
actual brake response exceeds a user specified maximum allowed 
brake response. This can be used to indicate that service to the brake 
should be performed. 
 
 
________________________________________________________
1.7 ALARM DETECTION 
 
The package detects the following alarms:  
 
Short Can Detection: The “Short Can Check” timing signal 
(CH02), along with the machine mounted short can sensor, is used to 
verify the entire length of the can. The short can sensor must see can 
the entire time the “Short Can Check” timing signal (CH02) is “on”. 
If the can is short (tear off) or any void is detected, the short can 
alarm is generated. The clutch is immediately de-activated as well as 
the cupfeed and rotary trip solenoids. The resolution of the short can 
check is 0.5 milliseconds. At a machine speed of 250CPM, this 
translates to approximately 1/4” resolution in can length. 
 
Die Sensor Failure: This alarm occurs when the short can sensor 
fails “on”. The “Sensor Check” timing signal (CH03) is used to verify 
that the short can sensor does indeed turn “off” when a can is not 
present. 
 
Timing Signal Fail: The timing signal fail occurs when any of the 
timing signals generated in the PLS section fail to change state 
periodically while the machine is running. 
 
Clutch Output Fail (No.1/No.2): These alarms occur when the 
respective clutch output (no.1 or no.2) fails either “on” or “off”. This 
indicates either a failure in the outputs of the S4568 board that drives 
the clutch or a short circuit or open circuit in the clutch output wiring. 
 
No Ram Motion Detected: This alarm occurs when the clutch is 
activated and no ram motion is detected after a time delay. This could 
indicate either the clutch did not activate or that a failure in the 
resolver coupling has occurred. 
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Resolver Fault - Motion Detected at Stop: This alarm occurs 
when motion is detected after the clutch has been disengaged for a 
time delay. This indicates either a broken wire in the resolver cable or 
a failure in the resolver windings. 
 
Brake Response Too Long: The “Brake Response Too Long” 
alarm is generated when the actual brake response exceeds a user 
specified maximum allowed brake response. This can be used to 
indicate that service to the brake should be performed. 
 
The “Short Can Alarm” is available to the host PLC as a discrete 
output. The balance of the alarms is summed together into the “Not 
HSM Alarm” discrete output. If any one these alarms occur the “Not 
HSM Alarm” is turned “off”. If all alarms are cleared, the “Not HSM 
Alarm” is “on”. These two outputs should be interlocked to the 
existing control system to disable the clutch logic. The respective 
alarm message is displayed on the HSM-WI7 Keypad/Display when 
the corresponding alarm is active. 
 
 
________________________________________________________
1.8 DATA COLLECTION 
 
The following data is collected for both the current shift and the 
previous (last) shift: 
 

1) Total Number of Good Cans Produced 
2) Total Number of Short Can Faults 

 
This data can be viewed locally on the Keypad/Display. This 
information is updated (“current” shift transferred to “Last” shift) 
based on the change of state of the “End of Shift” input. 

 
HSM-WI7 User’s Manual SYSTEMS Electronics Group 

 
- 9 - 



SECTION 1  
GENERAL DESCRIPTION 
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HSM-WI7 User’s Manual SYSTEMS Electronics Group 

 
- 10 - 



SECTION 2 
INSTALLATION 

The HSM-WI7 module is provided for door mounting on the existing 
user's control cabinet door or console.  
 
 
________________________________________________________
2.1 WHAT'S INCLUDED 
 
Verify that the following items are included when unpacking the 
HSM-WI7: 
 

1ea. HSM-WI7 M4503 Module with required I/O boards 
1ea. HSM-WI7 User's Manual 
1ea. HSM-WI7 Keypad Quick Reference 
1ea. M4500 User's Manual 
1ea. HSM-WI7 Program Disk 

 
The following items are optional items and can be purchased 
separately as required or desired: 
 

1ea. RSV34-MS1 Resolver 
1ea. RSV-RSCBLE-XX Resolver Cable 

 
 
________________________________________________________
2.2 POWER REQUIRED 
 
The HSM-WI7 is powered from 115/230VAC 50/60HZ and 
+24VDC. The 115/230VAC is used to power the HSM-WI7 module 
while the +24VDC is used to power the +24VDC I/O (sensors, clutch 
solenoids, etc.).  
 
Note: +24VDC solenoids must be used for all clutch, cupfeed, and 
air strip solenoids. These provide a much more consistent and 
repeatable response time than 115VAC solenoids. Assuming 
+24VDC solenoids were used in the existing system, the +24VDC 
current required by the HSM-WI7 is no more than the existing 
systems +24VDC current requirement therefore the existing +24VDC 
power supply should be adequate. 
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________________________________________________________
2.3 MOUNTING THE HSM-WI7 
 
The HSM-WI7 module should be mounted in the door of the existing 
user's cabinet or console door. Perform the following steps to mount 
the HSM-WI7 module: 
 
1) Referring to the recommended cut-out in figure 1, cut a cut-out 

 in the door of the existing user's control cabinet or console. 
 
 2) Remove the all the field wiring connectors from the top of the 

HSM-WI7 module. With the gasket installed on the HSM-WI7 
module mounting studs, slide the HSM-WI7 module into the cut-
out from the front. Attach the HSM-WI7 module to the door using 
the supplied hardware. 

 
 3) Once the module is installed, a lugged earth ground wire should 

be installed on one of the module mounting screws to insure that 
the HSM-WI7 is well grounded. 

 
________________________________________________________________________________ 

 

 
 

Figure 1 - HSM-WI7 Recommended Panel Door Cut-out 
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________________________________________________________
2.4 WIRING THE HSM-WI7 
 
Referring to the electrical control schematic at the back of this 
manual, wire the HSM-WI7 as follows: 
 
Note:  The HSM-WI7 contains removable field wiring connectors for 
ease of maintenance. It is generally easier to perform the wiring 
described below with the connectors removed from the module and 
then installing the connectors to the module once all wiring is 
complete. 
 
1) Incoming Power, (115VAC-230VAC to L, N, and G of HSM-WI7 

power connector and +24VDC to I/O connectors). 
 
2) Interlocks from existing control system to HSM-WI7 (inputs 

B100.0, B100.1, B100.2, B100.3, B100.4, B100.5, B100.6, 
B100.7, and B101.2). 

 
3) Interlocks to existing control system from HSM-WI7 (outputs 

B110.5, B110.6, and B110.7). 
 
4) Clutch, Cupfeed, Rotary Trip, and Air Strip solenoids. 
 
5) Short Can Sensor using three conductor shielded cable. The shield 

of the sensor cable should be tied to earth ground at a terminal 
inside the existing control cabinet and left floating at the sensor. 

 
6) Set-Up Enable (passcode by-pass) key switch (if desired). 
 
7) Resolver cable from resolver or existing PLS to RO-S4 connector 

on HSM-WI7 using a three pair, two conductor shielded cable. 
The shield of the resolver cable should be tied to the “SHLD” 
terminal of the HSM-WI7 resolver input connector.  Make sure 
the resolver cable shield is left floating at the resolver. 

 
8) Trimmer Speed reference (0-10V analog) from HSM-WI7 to 

trimmer drive (if used).  
 

Note:  In some applications it may be necessary to use an analog 
isolation amplifier (not provided) to isolate the drive from the 
HSM-WI7 module to prevent damage to the HSM-WI7 module. 
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In general, when wiring the HSM-WI7, keep all +24VDC wiring, 
resolver cable, and trimmer speed reference wiring away from high 
voltage wiring. 
 
 
________________________________________________________ 
2.5 MOUNTING THE RSV34-MS1 RESOLVER  
(IF REQUIRED) 
 
The HSM-WI7 is designed to interface to a resolver (not encoder) for 
machine timing. If the machine is not already equipped with a 
resolver, then the existing encoder will have to be removed and an 
RSV34-MS1resolver will have to be mounted in it's place. If this is 
the case, refer to the RSV34-MS1 data sheet for details on mounting 
the resolver. Use the RSV-RSCBLE cable to connect the resolver to 
the HSM-WI7. Route the resolver cable in a separate conduit, away 
from all other high voltage and control wiring. Wire the cable directly 
to the 8-pin resolver connector on the HSM-WI7 (see section 2.4). 
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________________________________________________________
2.6 HSM-WI7 SOFTWARE INSTALLATION 
 
The HSM-WI7 set-up software is used to  
• Download the Program to the HSM-WI7 Module 
• Tune (Set-Up) the User Adjustable Variables of the HSM-WI7 
• Download and Upload (Save) the User Set-Up Variables to Disk 
• View Shift Data  
 
Follow the steps below to install either the Windows or DOS based 
setup programs and PLC application program on a PC used to support 
the HSM-WI7 control system. 
 
 
________________________________________________________
2.6.1 WINDOWS™ BASED SET-UP PROGRAM 
INSTALLATION 
 
The HSMWI7 setup program is compatible with Windows 
95/98/ME/2000/XP operating systems. 
 
To install the set-up software, perform the following steps: 
 
1) Insert the HSM-WI7 CD into the drive 
 
2) From the Windows desktop, “Click” Start and then select run. 
 
3) From the “Run” dialog box, “Click” the Browse button.   
 
4) Select the drive with HSM-WI7 CD.  Select the “setup.exe” file 

and “Click” Open and then Ok. 
 
5) This will initiate the installation process.  Follow the instructions 

that appear on the screen to complete the installation process.  The 
HSMWI7 setup program can be executed from the “Systems” 
folder located in Programs. 
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________________________________________________________
2.6.2 DOS BASED SET-UP PROGRAM INSTALLATION 
 
To install the DOS based set-up software perform the following steps: 
 
1) Create one directory off the root directory of the PC for each 

bodymaker. These will be used to store the “HSMWI7.EXE” 
setup programs and HSMWI7 set-up data for each bodymaker.  

 
Create these directories by typing the following at the DOS 
prompt: 

 
 MD  \HSMWI1<ENTER> 
 MD  \HSMWI2<ENTER> 
 MD  \HSMWI3<ENTER> 
  etc. 
 
2) Install the “PROGRAMS” disk into the drive. For each “HSMWI” 

directory created, switch to that directory and install the “HSM-
WI7” set-up programs by typing the following at the DOS prompt 
(bodymaker #1 is shown): 

 
 CD  \HSMWI1<ENTER> 
 A:INSTALL<ENTER> 
 
3) Add each bodymaker’s HSM-WI7 set-up program to your 

computer's menu software by creating a selection for each 
bodymaker called “SET-UP W/I #1” for bodymaker #1, “SET-UP 
W/I #2” for bodymaker #2, etc.. The DOS commands executed for 
these selections should be (bodymaker #1 shown): 

 
 For the “SET-UP W/I #1” selection: 
  CD  \HSMWI1 
  HSMWI7  HSMWI7 
  CD  \ 
 
 4) To execute the respective bodymaker's set-up program, simply 

select the corresponding “SET-UP W/I” selection from the menu 
software's menu. 
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________________________________________________________ 
2.6.3 SYSdev PROGRAM DEVELOPMENT SOFTWARE 
INSTALLATION 
 
The SYSdev Program Development software is used to perform on-
line trouble-shooting and program modifications to the HSM-WI7. If 
SYSdev was purchased with the HSM-WI7 package and is not 
already installed on the your computer, install SYSdev onto the hard 
drive of your computer following the steps in the SYSdev Program 
Development manual. 
 
 
________________________________________________________ 
2.6.4 HSM-WI7 APPLICATION PROGRAM INSTALLATION 
 
The application program is a SYSdev based program, loaded into the 
M4500 module and performs the HSM-WI7 logic. The program is 
written in a combination of Ladder logic and High-level. If the user 
desires to make program changes or perform on-line monitoring of 
the program execution the files, which constitute the HSMWI7 
program, will have to be loaded onto the hard drive of the PC used to 
support the system. The SYSdev Program Development Software will 
also have to be loaded on the PC. To install this program perform the 
following: 
 
1) Install the “PROGRAMS” disk into the drive.  
 
2) For each of the "HSMWI7" directories (created in section 2.6.2), 

copy all the files from the disk to each of these subdirectories. 
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________________________________________________________ 
2.7 MODIFY EXISTING PLC PROGRAM 
 
Modify the existing control system PLC program to interface with the  
HSM-WI7 by incorporating the following into the existing PLC 
ladder logic: 
 
1) The HSM-WI7 now controls the clutch BDC stop, cupfeed, air 

strip, and short can detection. Defeat the existing short can 
detection in the PLC. Add the “Short Can Alarm” input from the 
HSM-WI7 and the “No HSM Alarm” interlock.  

 
Note:  These two alarms must be immediately disable the clutch 
logic in the PLC. The “Short Can Alarm” is true logic (“on” when 
alarm detected) while the “No HSM Alarm” is inverted logic 
(“off” when alarm is detected). 

 
2) Add the “Clutch On No.1” and “Clutch On No.2” outputs into the 

PLC logic. In general, these can be derived from the logic that use 
to drive the clutch solenoids by removing the BDC timing signal 
from the original logic. 

 
3) Add the “Continuous”, “Single”, and “Inch/Bar” Mode outputs to 

the existing PLC logic. The respective output should be  “on” 
when the corresponding mode is selected. 

 
4) Add the “Not Immediate Stop” output to the PLC logic. This 

should be “on” when no E-stop or immediate stop condition is 
present and turn “off” as soon as either condition occurs. In 
general, the clutch control as interfaced with the above six 
interlocks, should be implemented as defined in section  1.3. 

 
5) Add the “Cupfeed On” output into the PLC program. In 

continuous and single modes, this signal should be the summation 
of the cupfeed auto mode and all line control stand-by conditions 
(when “on”, the cupfeed will be timed opened by the HSM-WI7 
when the machine is running and  feed cups in the normal 
production mode). In inch mode, the  cupfeed will be opened 
when this output is “on”. 

 
6) Add the “Rotary Enable” output to the PLC program. This must 

be “on” to enable the rotary cam in normal production. 
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7) Add the “Alarm Reset” output. This signal should be “on” as long 
as the system reset push-button is depressed. 

 
________________________________________________________ 
2.8 HSM-WI7 SET-UP 
 
The HSM-WI7 is shipped from the factory with the PLC program 
“HSMWI7” loaded in the PLC section of the HSM-WI7 module and 
the PLS channel set-point file “WI7TMG” loaded in the PLS section. 
In most cases, the following user variables and timing channels may 
have to be altered to tune the HSM-WI7 to the actual bodymaker it is 
controlling. 
 
Once the HSM-WI7 is installed and the control system is powered 
back up, perform the following to set-up and tune the HSM-WI7. The 
set-up is performed using the Display/Keypad of the HSM-WI7 or a 
PC running the “HSMWI7” set-up program. See section 3 for a 
description of the Keypad commands and menu displays of the HSM-
WI7 Display/Keypad. See section 4 for a description of the menus, 
variables and how to use the Windows based set-up program. See 
section 5 for a description of the menus, variables and how to use the 
DOS based set-up program. 
 
 
________________________________________________________ 
2.8.1 DEFAULT SET-UP VARIABLES 
 
As shipped, the user variables for the HSM-WI7 are set to the 
following defaults: 
 
 Brake Wear Compensation: 
  Enabled  : N 
  Desired BDC Stop Position (Low Speed)  : 000 
  Desired BDC Stop Position (High Speed)  : 000 
 
 Maximum Allowed Stopping Response (degrees)  : 300 
 
 Bodymaker Running Speeds: 
  Low Speed (SPM)  : 250 
  High Speed (SPM)  : 350 
 
 Trimmer Speed Reference: 
  Maximum Speed  : 375 
  Idle Speed (W/I stopped)  : 250 
  High Speed Offset  : 20 
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The “WI7TMG” timing channel file, as shipped, contains the 
following default timing set-points: 
 
 CHAN ON - OFF DESCRIPTION 
 
 CH00: 150 - 170 BDC (high) Timing 
 CH01: 180 - 200 BDC (low) Timing 
 CH02: 155 - 175 Short Can Check Timing 
 CH03: 110 - 130 Sensor Check Timing 
 CH04: 230 - 300 Cupfeed Timing 
 CH05: 150 - 200 Air Strip (low) Timing 
 CH06: 120 - 190 Air Strip (high) Timing 
 CH07: 180 - 000 PLC Clock Timing 
 CH10: 000 - 030 Motion (“on” for 30, “off” for 30 thru-out) 
 CH11: ___ - ___ spare 
 CH12: ___ - ___ spare 
 CH13: ___ - ___ spare 
 CH14: ___ - ___ spare 
 CH15: ___ - ___ spare 
 CH16: ___ - ___ spare 
 CH17: ___ - ___ spare 
 
   
________________________________________________________ 
2.8.2 SET BODYMAKER SET-UP PARAMETERS 
 
The Bodymaker set-up parameters include: enabling or disabling the 
brake wear compensation, setting the desired low and high speed 
stopping points (if the brake wear compensation is enabled), setting 
the maximum allowed stopping response, and setting the bodymaker 
running low and high speeds. 
 
Brake Wear Compensation: If the brake wear compensation is to 
be used, enable it by setting the “Brake Wear Compensation Enable” 
to “Y”. Set the “Desired BDC Stop Position (Low)” and “(High)” as 
well if the compensation is enabled.  The “Desired BDC Stop 
positions” are the location you want the ram to be at when it comes to 
rest after a BDC stop. Both the “Low” and “High” desired stopping 
positions are generally set to 000 degrees. Enabling the brake wear 
compensation allows the HSM-WI7 to automatically adjust the BDC 
timing channels (CH00-High) and (CH01-Low) as necessary such 
that the press will stop at the desired stopping position regardless of 
the actual brake response. 
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If the brake wear compensation is not to be used, disable it by setting 
the “Brake Wear Compensation Enable” to “N”. Disabling the brake 
wear compensation requires the BDC (High) timing (CH00) and the 
BDC (Low) timing (CH01) signals to be set manually such that the 
press stops at BDC.  
 
Note: If the brake response then changes, the press will not stop at 
the desired position if the brake wear compensation is disabled. 
 
Maximum Allowed Stopping Response: This parameter defines 
what the maximum allowed brake response is before the “Brake 
Response Too Long” alarm is generated. If the actual brake response 
(number of degrees from when the brake is activated to the position 
where the press ends up at rest) when a BDC stop is performed is 
longer than this number, the alarm is generated. If the actual brake 
response is less, the alarm is not generated. Set this parameter to the 
value where the brake response is considered too long and service to 
the brake should be performed (typically 270 to 300 degrees). 
 
Bodymaker Running Speeds: Set the Bodymaker running “Low 
Speed” and “High Speed” to the speeds that the bodymaker will 
actually run at when the respective speed is selected.  
 
Note: This is not a speed reference that will make the bodymaker run 
at the speeds entered but is instead simply parameters used by the 
HSM-WI7 to know when to switch between the BDC (Low) and BDC 
(High) timing as well as the Air Strip (Low) and (High) timing etc. 
 
See section 3.4 (HSM-WI7 Keypad/Display) or section 4 (Windows 
based set-up program) or section 5 (DOS based set-up program) for 
details on setting the above set-up parameters. 
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________________________________________________________ 
2.8.3 SET TRIMMER SPEED REFERENCES 
 
Set the “Trimmer Maximum Speed”, “Trimmer Idle Speed”, and 
“Trimmer High Speed Offset” as desired. These three parameters are 
used to actually control the speed of the trimmer (via the 0-10VDC 
trimmer speed reference output of the HSM-WI7 module). 
 
Trimmer Maximum Speed: The “Trimmer Maximum Speed” 
parameter is used to scale the 0-10VDC analog output such that when 
the bodymaker is running at the speed entered in “Trimmer Maximum 
Speed”, the analog output will be at 10 volts. 
 
Trimmer Idle (Minimum) Speed: This parameter determines the 
speed the trimmer will run at when the bodymaker is stopped (de-
clutched).  
 
Note: When the bodymaker is running, the trimmer speed reference 
is proportional (as set by the “Trimmer Maximum Speed” scaling) to 
the speed of the bodymaker. This parameter is used to provide the 
speed reference when the bodymaker speed is zero. 
 
Trimmer High Speed Offset: This parameter is used to modulate 
the speed of the trimmer as a function of cans present at the infeed of 
the trimmer. A high infeed sensor can be added to the trimmer infeed 
such that the trimmer will run at the bodymaker running speed plus 
the “Trimmer High Speed Offset” value. This allows the trimmer to 
speed up when the infeed to the trimmer backs-up and slow down 
once the trimmer runs the cans out. 
 
See section 3.4 (HSM-WI7 Keypad/Display) or section 4 (Windows 
based set-up program) or section 5 (DOS based set-up program) for 
details on setting the above set-up parameters. 
 
 
________________________________________________________ 
2.8.4 SET MACHINE ZERO 
 
Inch the bodymaker to back dead center (BDC) and set the HSM-WI7 
resolver offset per section 3.4 (HSM-WI7 keypad) or section 4 
(Windows based set-up program) or section 5 (DOS based set-up 
program). 
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________________________________________________________ 
2.8.5 VERIFY LOCATION OF SHORT CAN TIMING (CH02) 
 
By inching the machine, verify that the “Short Can” timing (CH02) of  
the HSM-WI7 first turns “on” when the short can sensor is over the 
nose of the punch on the forward portion of the stroke (see figure 2). 
This would be where the sensor would first “see” the can as it 
emerges from the die set. Verify that the “Short Can” timing turns 
“off” right before the sensor would quit seeing the lip of the can as the 
ram continues it's forward motion. Adjust either or both of the turn 
“on” or turn “off” locations of CH02 until the above is achieved. 
Depending on the location of the short can sensor, CH02 is typically 
set “on” at 155 degrees and then back “off” at 175 degrees. 
 

________________________________________________________________________________ 
 

 
 

Figure 2 - Short Can Check Timing Sequence 
 

________________________________________________________________________________ 
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Note:  The short can sensor must “see” can the entire time the  
“Short Can” timing (CH02) is “on” in order to pass the short can 
check. Otherwise, the “Short Can” alarm will be generated. 
 
At this time, also verify that the “Sensor Check” timing (CH03) is 
also set correctly. This timing signal should go “on” for 20 degrees 
then back “off” just prior to the punch emerging from the die set 
(typically 110 to 130 degrees). This signal is used to verify that the 
short can sensor has not failed “on” and therefore the short can sensor 
must be “off” the entire time CH03 is “on” otherwise the “Die Sensor 
Fail” alarm is generated. 
 
 See section 3.4 (HSM-WI7 Keypad/Display) or section 4 (Windows 
Based set-up program) or section 5 (DOS Based set-up program) for 
details on setting CH02 and CH03. 
 
 
________________________________________________________ 
2.8.6 VERIFY MACHINE OPERATION 
 
Once steps 2.8.2 thru 2.8.5 are complete, run the machine in normal 
production (both at low and high speeds where practical) and verify 
the following: 
 
Verify Air Strip Timing: With the machine running, with the 
cupfeed open, verify that the cans are stripped with-out any problems 
and that no blow-outs are occurring (verify at both low and high 
speed if a problem is occurring, adjust the respective “Air Strip” 
timing (CH05-Low Speed, CH06-High Speed) until the problem is 
corrected. See section 3.4 (HSM-WI7 Keypad/Display) or section 4 
(Windows based set-up program) or section 5 (DOS based set-up 
program) for details on adjusting CH05 and CH06. 
 
Verify Short Can Timing: With the machine running with the 
cupfeed open, verify that no false short can faults are occurring (short 
can alarm occurs when full length can is made). If false short can 
alarms are occurring, narrow the short can timing one degree at a time 
until the false short can alarms quit occurring. 
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Verify that the short can detection is working correctly by generating 
a short can and verifying that the short can alarm is generated for this 
can. This can be done by stopping the press, removing one of the die 
rings then punching a cup in single stroke mode with the die ring 
removed. The short can alarm should be generated when the first cup 
is punched. 
 
Verify BDC Stops: If the brake wear compensation is enabled, 
verify that the press does stop at the desired location in both the high 
and the low speeds.  
 
Note: When the HSM-WI7 is first installed, it will take a few 
successive stops for the algorithm to program the BDC timing 
channels to the correct position. Also, the compensation is enabled 
after the press has been running at a fixed speed in continuous. The 
BDC timing channels will not be modified when single strokes are 
made or if press is started in continuous and then immediately 
stopped again. Wait about 5 seconds after the press is started before 
performing the BDC stop to verify the stop position. 
 
If the brake wear compensation is disabled, manually adjust both the 
BDC (High) timing (CH00) and the BDC (Low) timing (CH01) such 
that the press stops at back dead center at both respective speeds.  See 
section 3.4 (HSM-WI7 Keypad/Display) or section 4 (Windows based 
set-up program) or section 5 (DOS based set-up program) for details 
on adjusting CH00 and CH01. 
 
 
The Machine Is Now Set-Up and Ready To Run. 
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________________________________________________________ 
2.9 HSM-WI7 MODULE REPLACEMENT 
 
The following is provided only as a reference. These steps need only 
be performed in the event the HSM-WI7 module needs to be replaced 
once installed. To replace the module, perform the following: 
 
1) Turn both 115VAC and +24VDC power to the module “off” and 

remove all the field wiring connectors from the module. 
 
2) Remove the 8-32 nuts and lock washers (7ea.) which retain the 

module in the door and remove the module. 
 
3) Remove the supplied field wiring connectors from the new 

module and install the new module in the door cut-out from the 
front and re-install the 8-32 nuts and lock washers (7ea). 

 
4) Install the existing pre-wired field wiring connectors on all the I/O 

boards of the module (115VAC power connector, I/O slots0 and 
1, resolver connector, and IN0/IN1 connector). Make sure all the 
field wiring connectors are fully mated in the module. 

 
5) Apply 115VAC and +24VDC power to the module and verify that 

the “PWR” and “RUN” LEDs on the module are “on” and the 
“FLT” LED is “off”. 

 
6) Connect an RS-232 cable from the computer COM port to the 

“PROG” port on the HSM-WI7. 
 
7) From the computer's menu program, select the respective 

bodymaker's “SET-UP W/I” selection (this was set in section 
2.6.2). The “HSMWI7” set-up program will be invoked with the 
corresponding HSMWI7 application program for that bodymaker. 

 
8) Download the PLS timing set-points to the module by selecting 

“2: Machine Timing” from the HSM-WI7 main menu. From the 
PLS main development menu, select “4: Download Channels to 
PLS”. Press the <ENTER> key to start the download. Press any 
key to return back to the PLS main development menu. Press 
12<ENTER> to return back the HSM-WI7 main menu. 
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9) Download the previously saved to disk set-up data to the module 
by selecting “5: Download Set-up data to Module” from the HSM 
main menu. Press the <ENTER> key to start the download. Once 
the download is complete, press any key to return to the HSM-
WI7 main menu. See section 5.5 for complete details. 

 
10) The HSM-WI7 is now ready to run, loaded with the HSMWI7 

timing set-points, and set-up data that was previously saved for 
the respective bodymaker. Press <ESC> to return back to the 
computer's menu software program. 
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The keypad of the HSM-WI7 contains 24 keys consisting of data 
display commands, set-up commands, and a numeric keypad. The 
display of the HSM-WI7 is a 2 line by 40 character back-lit LCD 
display which displays the selected data and set-up menus. The 
keypad/display can be used by the operator to view data or can be 
used to adjust the timing and all set-up parameters. 
 
 

 
 
The display/keypad allows the following to be viewed or adjusted: 
 

1) Set the Bodymaker Set-Up Parameters 
2) Set the Trimmer Set-Up Parameters 
3) Set Machine Timing 
4) Set Machine Zero 
5) View the Actual Brake Response (in degrees) 
6) View the Current Shift Data 
7) View the Last Shift Data 

 
The definitions of the keypad commands and menus are described in 
the following sections.  
 
Note: For virtually all the menus, the “NEXT” and “PREV” keys can 
be used to advance to the next item of the menu or retard to the 
previous item on the menu. 
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________________________________________________________ 
3.1 DEFAULT SCREEN 
 
The default screen (displayed when no other commands are active) 
contains the following data: 
 

MACHINE SPEED (SPM):xxxx   POSITION:xxx 
GOOD CANS:xxxxxxx        SHORT CANS:xxxxxx 

 
Where: 
• The “Machine Speed” is the Current Speed of the Bodymaker 
• The “Position” is the Current Angular Position of the Bodymaker 

Crankshaft 
• The “Good Cans” Field is the Total Number of Good Cans 

Produced so Far Into the Current Shift 
• The “Short Cans” Field is the Total Number of Short Can Faults 

the Machine has had so Far into the Current Shift 
 
This display effectively replaces a speed meter, a position display, 
and two can counters. This screen is always returned to when no 
commands are active. 
 
 
________________________________________________________ 
3.2 “BRAKE RESPONSE” KEY 
 
This key displays the brake response of both low speed and high 
speed stops. The response is the number of degrees it takes the press 
to stop from when the clutch is de-activated for a BDC stop to the 
position that the machine comes to rest. This can be used to determine 
the general condition of the brake and whether servicing of the brake 
is required. To exit back to the default screen, simply press the “ESC” 
key. 
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________________________________________________________ 
3.3 “LAST SHIFT” KEY 
 
The Last shift data menu displays the “Total Good Can” count and the 
“Total Short Can” fault count. This data is the totals for the last 
(previous) shift. This data is transferred from the current shift to the 
“Last shift” data when the end of shift input transfers from a “0” to a 
“1”. This can be at the end of either an 8 or 12 hour shift. This data is 
only reset at the end of shift transition.  
 
Note:  The Current shift “Good Cans” and “Short Cans” is displayed 
as part of the default screen. 
 
The Last shift data is defined as follows: 
 
Good Cans: This is the total number of good cans produced for the  
previous shift. This is essentially a can counter. 
 
Short Cans: This is the total number of short can faults the machine 
had the previous shift. 
 
 
________________________________________________________ 
3.4 “SET-UP” KEY 
 
This selection is used to invoke the primary set-up menu. This 
consists of the following four selections: 
 

1: SET BODYMAKER PARAMETERS 
2: SET TRIMMER PARAMETERS 
3: SET MACHINE TIMING (SET-POINTS, ETC.) 
4: ZERO MACHINE (SET RESOLVER OFFSET) 

 
When selected, each of the above selections brings up a sub-menu 
with the corresponding set-up parameters. The following sections 
describe these sub-menus and the definitions of the corresponding 
variables. To select the respective set-up sub-menu, simply press the 
corresponding numeric key (1 thru 4). 
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Note:  The primary set-up menu is passcode protected. When the set-
up key is first depressed, an “ENTER PASSCODE:” prompt is 
displayed. A 5-digit passcode must be entered followed by pressing 
the <ENTER> key. If the passcode entered is correct, the primary set-
up menu is then displayed and any of the parameters accessed by this 
menu may be changed. If the passcode entered is incorrect, the 
message “INCORRECT PASSCODE” will be displayed. At this time 
the passcode may be entered again or  the <ESC> key can be pressed 
to return back to the main menu. 
 
When the passcode is entered, the digits entered are not displayed. 
Instead “*” characters are displayed as each digit is entered. This 
prevents unauthorized personnel from observing the passcode as it is 
entered. In addition, the “ENTER PASSCODE” prompt is only 
displayed for a maximum of 60 seconds. The correct passcode must 
be entered within this 60 second period otherwise the set-up mode is 
aborted and the main menu is re-displayed. 
 
Refer to section 3.5 (Set Keypad/Display “Set-up” passcode) for 
details on setting the passcode as desired. 
 
For user's that would prefer to use a keyed switch to prevent 
unauthorized access instead of a passcode, the “Set-Up Enable” input 
can be used. When this input is “on”, the passcode prompt is bypassed 
and access to the primary set-up menu is provided immediately.  If 
the “Set-Up Enable” input is “off”, then the normal passcode prompt 
is displayed. A keyed switch can then be wired to the “Set-Up 
Enable” input such that when the switch is in the enable position, the 
input is “on”. 
 
The “NEXT” and “PREV” keys can be used to advance to the next 
parameter or the previous parameter respectively. To change the 
currently displayed parameter, simply enter the new value on the 
numeric keypad and press <ENTER>. The value will be entered and 
the next parameter will automatically be displayed. When the last 
parameter is entered, the primary set-up menu is again displayed. 
Pressing <ESC> at anytime will also exit you back to the                
primary set-up menu. 
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________________________________________________________ 
3.4.1 SET BODYMAKER PARAMETERS 
 
This menu is activated when the “1” key (SET BODYMAKER 
PARAMETERS) is pressed while the primary set-up menu is active. 
The following four set-up parameters may then be adjusted or viewed: 
 
Brake Wear Comp Enble? (0=No, 1=Yes): This prompt is used 
to enable or disable the brake wear compensation. If the 
compensation is to be disabled, enter “0” and press <ENTER>. If the 
compensation is to be enabled, enter “1” and press <ENTER>. 
 
Desired BDC Stop POS (Low Speed): This is the desired 
stopping location (in degrees) for a BDC stop in low speed when the 
brake wear compensation is enabled. This is typical set to 000 degrees 
(Back Dead Center). This prompt is only displayed when the brake 
wear compensation is enabled. 
 
Desired BDC Stop POS (High Speed): This is the desired 
stopping location (in degrees) for a BDC stop in high speed when the 
brake wear compensation is enabled. This is typical set to 000 degrees 
(Back Dead Center). This prompt is only displayed when the brake 
wear compensation is enabled. 
 
Maximum Allowed Stopping Response: This defines what the 
maximum allowed brake response is before the “Brake Response Too 
Long” alarm is generated. If the actual brake response (number of 
degrees from when the brake is activated to the position where the 
press ends up at rest) when a BDC stop is performed is longer than 
this number, the alarm is generated. If the actual brake response is 
less, the alarm is not generated. Set this parameter to the value where 
the brake response is considered too long and service to the brake 
should be performed (typically 270 to 300 degrees). 
 
Running Bodymaker Low Speed (SPM): This is the speed (in 
strokes per minute) the bodymaker will run when in low speed. 
 
Running Bodymaker High Speed (SPM): This is the speed (in 
strokes per minute) the bodymaker will run when in high speed. 
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________________________________________________________ 
3.4.2 SET TRIMMER PARAMETERS 
 
This menu is activated when the “2” key (SET TRIMMER 
PARAMETERS) is pressed while the primary set-up menu is active. 
The following trimmer set-up parameters may then be adjusted or 
viewed: 
 
Trimmer Maximum Speed (CPM): The “Trimmer Maximum 
Speed” parameter is used to scale the 0-10VDC analog output such 
that when the bodymaker is running at the speed entered in “Trimmer 
Maximum Speed”, the analog output will be at 10 volts. This is 
typically set to the running high speed of the Bodymaker or slightly 
higher. 
 
Trimmer Minimum Speed (CPM): This parameter determines the 
speed the trimmer will run at when the bodymaker is stopped (de-
clutched).  
 
Note: When the bodymaker is running, the trimmer speed reference 
is proportional (as set by the “Trimmer Maximum Speed” scaling) to 
the speed of the bodymaker. This parameter is used to provide the 
speed reference when the bodymaker speed is zero.  
 
Trimmer High Speed Offset: This parameter is used to modulate 
the speed of the trimmer as a function of cans present at the infeed of 
the trimmer. A high infeed sensor can be added to the trimmer infeed 
such that the trimmer  will run at the bodymaker running speed plus 
the “Trimmer High Speed Offset” value. This allows the trimmer  to 
speed up when the infeed to the trimmer backs-up and slow down 
once the trimmer runs the cans out. 
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________________________________________________________ 
3.4.3 SET MACHINE TIMING (SET-POINTS, ETC.) 
 
This selection brings up the timing set-point menu which displays the  
following fields: 
 

CHuu  SETPOINT:xxx   []  “channel name” 
RPM:yyyy    POS:zzz     OFFSET:wwww  SCALE:360 

 
 
Each field is defined as follows: 
 
Field Definition 
Chuu Currently selected channel (CH00 thru  CH17) 

where “uu” is the octal channel  number. 
 
SETPOINT:xxx Channel “on” or “off” set-point where “xxx”  is 

the set-point position 
 
[] State of channel set-point (blank = “off”,  solid 

block character = “on”) 
 
“channel name” selected channel name: (CH00) BDC  (HIGH) 

TIMING, (CH01) BDC (LOW)  TIMING, etc. 
 
RPM:yyyy Current machine speed where “yyyy” is in  CPM. 
 
POS:zzz Current resolver position where “zzz” is in 

degrees. 
 
OFFSET:wwww Resolver offset where “wwww” is the offset  in 

degrees. 
 
SCALE:360 Resolver SCALE FACTOR (360 degrees per 

revolution). 
 
In addition to displaying the timing set-point menu, the following 
keys are also enabled: “ENTER SET-POINT”, “CLEAR 
CHANNEL”, “SELECT CHANNEL”, and “SEARCH CHANNEL”. 
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The “ENTER SET-POINT” key is used to enter a new set-point (both 
“on” and “off” set-points) in the selected channel. The “CLEAR 
CHANNEL” key is used to clear all set-points from the selected 
channel. The “SELECT CHANNEL” key is used to select a new 
channel for programming. The “SEARCH CHANNEL” is used to 
view both the “on” and “off” set-points in the selected channel. 
 
Searching Channel: To view the set-points in a channel simply 
press the “SEARCH CHANNEL” key. The next “off” to “on” or “on” 
to “off” position is shown in the “SETPOINT” field. If the transition 
was “off” to “on”, the state character [] will be a solid block. If the 
transition was “on” to “off”, the state character [] will be blank. 
 
Entering or Adjusting Set-point: To set or adjust a timing 
channel, perform the following: 
 
1) Select the channel to be adjusted by pressing the “SELECT 

CHANNEL” key, entering the channel number (00 to 17) and 
pressing <ENTER>. In addition, the “NEXT” and “PREV” keys 
can be used to advance to the next channel or retard to the 
previous channel. 

 
2) Press “CLEAR CHANNEL” to clear the existing set-point out. 
 

Note:  Entering a new set-point does not automatically clear the 
old set-point out. If the two set-points are not in the same place, 
the channel will simply have two set-points in it if the old one is 
not cleared out first. Therefore, always clear the channel before 
entering a new set-point. A set-point may, however, be 
“extended” by programming another set-point onto an existing 
set-point using either the existing “on” or “off” set-point as the 
starting position for the new set-point. This will result in one 
larger set-point. 

 
3) Press “ENTER SET-POINT” to enter the new set-point. The 

display will then prompt “ON SETPOINT:”. Enter the position (in 
degrees) where the set-point should go “on” and press <ENTER>. 
The display will now prompt “OFF SETPOINT:”. Enter the 
position (in degrees) where the set-point should go “off” and press 
<ENTER>. The channel will now be programmed with a set-point 
that goes “on” at the “on” position entered and “off” at the “off” 
position entered. 
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4) Exit back to the primary set-up menu by pressing <ESC>. Exit 
back to the default screen by pressing <ESC> again. 

 
 
________________________________________________________ 
3.4.4 ZERO MACHINE (SET RESOLVER OFFSET) 
 
This selection is used to auto zero the resolver. To set the machine 
zero (resolver offset) perform the following: 
 
1) Select “3: SET MACHINE TIMING” and observe the “POS:” 

field. Verify that as the machine is rotated forward (either inched 
or barred) that the position increases linearly from 0 through 359. 
If not, swap the S1 and S3 leads of the resolver at the HSM-WI7 
resolver connector. Then verify that the position then indeed does 
increase with forward movement. Press <ESC> to exit back to the 
primary set-up menu. 

 
2) Position the machine at machine zero (back dead center). 
 
3) Auto zero the resolver by selecting “4: ZERO MACHINE” from 

the primary set-up menu. Enter “0” to zero the resolver. The 
timing set-up menu will be displayed, now showing the “POS:” at 
zero. 

 
4) The HSM-WI7 will calculate the actual offset value required to 

make this the 000 position and will display this number in the 
offset field. 

 
5) Exit back to the primary set-up menu by pressing <ESC>. Exit 

back to the default screen by pressing <ESC> again. 
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________________________________________________________ 
3.5 SET KEYPAD/DISPLAY “SET-UP” PASSCODE 
 
The “Set Passcode” input to the HSM-WI7 is used to actually set or 
view the passcode of the set-up menu. Normally this input should be 
“off”. When the passcode is to be set, jumper this input to +24VDC 
and press the “Set-Up” key. The “ENTER PASSCODE” prompt will 
be displayed and the current 5-digit passcode will be displayed with 
the prompt. This allows the passcode to be viewed if necessary. 
 
If the passcode is to be changed, enter any number between 0 and 
64999 and press <ENTER>.  
 
Note: If passcode protection is not to be used, set the passcode to 
“0”. Then when the passcode is prompted for after the “Set-up” key is 
pressed, simply press <ENTER> to proceed to the set-up menu. If the 
passcode protection is used, set the passcode to a number between 1 
and 64999. Then when the “Set-up” key is pressed, the actual valid 
passcode number will have to be entered in order to gain access to the 
set-up menu. 
 
Once the passcode is set, turn the “Set Passcode” input back “off”. 
The set-up menu will be passcode protected with the number you 
have entered as the passcode. 
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The Windows based set-up program is menu driven, allowing the user 
to easily view data, alter set-up variables or set machine timing 
(resolver offset, timing signal locations, etc.), using a PC running the 
Windows (95/98/ME/2000/XP/NT) operating system. The set-up 
variables are used to configure and tune the M4500 to match the 
configuration and performance of the specific bodymaker (see HSM-
WI7 Set-up, section 2.8). 
 
Note:  The set-up program is an on-line communications program 
used to interface with the M4500 module.  The data displayed and set 
in the windows is communicated directly to the module, while in the 
“Online” edit mode. Therefore, prior to going online with the 
processor, make sure an RS-232 cable is connected from the COM 
port on the computer to the "PROG" port on the M4500.  The 
variables displayed while in the “Online” edit mode are read directly 
from the processor.  Data is saved to a “Set-up Data” file (*.sdt) 
whenever changes are made to a parameter or if the data is uploaded 
from the processor. 
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________________________________________________________ 
4.1 GENERAL DESCRIPTION 
 
Title Bar:  At the top of the window is the “Title Bar”.  The title bar 
is used to display the name of the working “Set-up Data” file, as well 
as, the name of the active “Window”.  The title bar is dark if the 
window is active and grayed if another window is active.  The color 
depends on the settings of the Display Properties of the Control Panel. 
 
Status Bar:  At the bottom of the window is the “Status Bar”.  The 
status bar is used to display system messages, online or offline mode, 
as well as, the current time and date as set by the operating system.  
The system messages panel displays general information about 
operation of the system.  The Online/Offline mode panel displays the 
status of the current set-up program mode of operation.  The mode of 
operation can be changed by simply double clicking the online/offline 
mode panel. 
 
Hot Keys:  Hot keys are activated by holding down the “ALT” key 
and simultaneously pressing the underlined letter of the desired 
function.  Almost every function can be activated by either pressing a 
series of hot keys or using the “TAB” key to move between fields. 
 
Online/Offline Modes:  The set-up program allows the user to 
make changes while “Online” with the processor.  The “Offline” 
mode is used to preset parameters prior to download.  All functions 
are available to the user while “Online”, however, specific “Online” 
functions are disabled in the “Offline” edit mode. 
 
Note:  Offline changes can only be made by enabling “Offline 
Editing”, accessed from the “Edit” menu. 
 
Getting Help:  The entire contents of the user’s manual is contained 
within the help file.  Pressing Ctrl+H will display the help file 
window.  Pressing the F1 key will display the contents file.  Hot spots 
allow jumps to other topics to display additional information as 
desired.  Selecting “About HSMWI7” from the Help menu will 
display a dialog box listing information about the current revision of 
the setup program and how to obtain technical support. 
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________________________________________________________ 
4.2 THE FILE MENU 
 
The “File” menu allows the user to perform the following functions: 
 
• Create a “New” set-up “Data File”. 
• Open an existing “Data File”. 
• Save any changes made to the current “Data File” to disk. 
• Upload (save) Data from the Processor. 
• Download a SYSdev (.sdv) program to the processor 
• Download (restore) Data from the current set-up “Data File” to 

the processor 
• Print a Report of the current set-up parameters. 
• Exit the set-up program 
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________________________________________________________ 
4.2.1 THE SET-UP DATA FILE 
 
The set-up “Data File” (.sdt) is a binary access file, designed for fast 
file I/O operation.  When the set-up program is first invoked, the 
default set-up parameters are loaded into memory.  If changes are 
made to any of the set-up parameters (either online or offline), as well 
as shift data, the user will be flagged to “Save Changes” upon exit of 
the program. 
 
Note:  Any windows based “Set-up” program can open a set-up 
“Data File”, however, the data tables will not be properly aligned.  
The user will be alerted to the problem if a set-up data file has been 
created by either a different set-up program or a different revision of 
the software. 
 
The set-up “Data File” is similar to that of a word processing file.  
When the program first starts, a default file is loaded and the user is 
able to make any changes as desired.  The set-up program is unaware 
of the settings and parameters that exist within the M4500.  
Therefore, to normalize the set-up program with the processor, the 
user should define or open an existing file, then upload “All” 
variables from the processor.  This allows the user to either create a 
backup of the data or maintain an existing file.  The user can even 
open a data file for another bodymaker, save the file to a new name, 
make the necessary changes and simply download the new parameters 
to another processor. 
 
The following functions can be accessed any time, from any set-up or 
display windows. 
 
New:  To create a “New” data file, select “New” from the “File” 
menu or press “Ctrl + N”.  This creates a completely new file, loaded 
with the default variables and the word “[unnamed]” is displayed in 
the title bar.  If any changes were made to the existing file, the user is 
prompted to save changes to the existing file. 
 
Open:  To “Open” and existing data file, select “Open” from the 
“File” menu or press “Ctrl + O”.  This displays a dialog box allowing 
the user to select an existing data file to open. The name of the file 
will be displayed in the title bar.  If any changes were made to the 
existing file, the user will be prompted to save any changes before 
terminating the program. 
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Save:  To “Save” data file to disk, select “Save” from the “File” 
menu or press “Ctrl + S”.  This displays a dialog box allowing the 
user to select a folder and enter a name for the file.  The user will be 
notified if the file already exists and the extension “.sdt” will 
automatically be added to the file name.  If this is a “New” file, the 
user will be prompted to enter a file name. 
 
Save As:  To save the data file to a new name, select “Save As” 
from the “File” menu..  This displays a dialog box allowing the user 
to select a folder and enter in a new name for the file.  The user will 
be notified if the file exists and the extension “.sdt” will automatically 
be added to the file name. 
 
Export Shift Data…:  This function allows the user to export the 
shift data to a “Tab Delimited” text file.  This allows the user to easily 
use the shift data to produce production reports. 
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________________________________________________________ 
4.2.2 UPLOAD (SAVE) DATA 
 
The “Set-up” program allows the user to upload set-up parameters, 
timing channel set-points and shift data from the M4500 into a set-up 
“Data File”.  This function is accessed from the “File” menu and the 
user is given the choice of the following options: 
 

 
 
Set-up Parameters:  This option uploads the “Set-up” data from 
the M4500.  This includes bodymaker and trimmer set-up parameters. 
 
Timing Channels:  This option uploads the “Machine Timing” 
channel set-points, as well as, the PLS configuration and scale factor. 
 
Shift Data:  This option uploads the “Shift Data” from the M4500.  
This includes the total good cans and total short cans for both the 
current and last shifts. 
 
All:  This option allows the user to completely upload “All” of the 
set-up parameters, timing channel set-points and shift data from the 
M4500. 
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________________________________________________________ 
4.2.3 DOWNLOAD PROGRAM 
 
The “Set-up” program allows the user to “Download” any SYSdev 
program file to the M4500. 
 

 
 
Note:  To “Download” a SYSdev program to the processor, the 
program must be “Online”.  If “Online” mode cannot be achieved, 
program download will not be executed.  If the program is currently 
“Offline”, the user will be prompted to first go “Online”. 
 
Once selected, and the set-up program “Online” with the processor, a 
dialog box will be displayed, allowing the user to select the SYSdev 
file to download. 
 
Note:  Only the files with the “.sdv” file extension will be displayed.  
It is important to keep in mind that only a valid M4500 PLC SYSdev 
file can be downloaded through the set-up program.  Care should be 
taken when selecting a program to download. 
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Once selected, a message box is displayed informing the user of the 
current program, revision and checksum of the program loaded in the 
processor, as well as, that of the selected program.  The user must 
confirm their selection by clicking the “Yes” command button.  After 
the user confirms their choice, program download is initiated and the 
current program download address is displayed.  When program 
download is complete, the user is prompted to acknowledge.  Control 
is passed back to the main program and the set-up program remains in 
an “Online” edit mode. 
 
 
________________________________________________________ 
4.2.4 DOWNLOAD (RESTORE) DATA 
 
The set-up program allows the user to download  “Set-up” 
parameters, timing channel set-points and shift data to the M4500 
from the set-up “Data File”.  This function is accessed from the “File” 
menu and the user is given the choice of the following options: 
 

 
 
Set-up Parameters:  This option downloads the “Set-up” data to 
the M4500.  This includes bodymaker and trimmer set-up parameters. 
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Timing Channels:  This option downloads the “Machine Timing” 
channel set-points, as well as the PLS configuration and scale factor 
to the M4500 PLS. 
 
Shift Data:  This option downloads the “Shift Data” to the M4500.  
This includes the total good cans and total short cans for both the 
current and last shifts. 
 
All:  This option allows the user to completely download “All” of the 
set-up parameters, timing channel set-points and shift data to the 
M4500. 
 
Note:  Only the values contained within the current data file are used.  
If the validity of the current data file is questionable, review the data 
in an “Offline” mode prior to download. 
 
________________________________________________________ 
4.2.5 PRINT REPORT 
 
The “Set-up” program allows the user to generate a “Report” printout 
of all the set-up parameters, timing channel set-points and shift data.  
This function is accessed from the “File” menu. 
 
At the top of each page, the report displays the name of the set-up file 
being printed.  At the bottom of each page is the date and time the 
document was printed, as well as, the page number. 
 
To printout a report of the settings contained in the set-up “Data File”, 
perform the following: 
 
1) From the “File” menu, select “Print Report” or press “Ctrl + P”.  

This displays the “Print Setup” dialog box, allowing the user to 
select a printer, as well as, the paper size and orientation.  Once 
the user selects “OK”, the report is generated and sent to the 
specified printer device.  This function makes use of the windows 
print manager, which allows the user to continue with their work 
while the document is being printed. 
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________________________________________________________ 
4.3 THE EDIT MENU 
 
The “Edit” menu allows the user to perform the following functions: 
 
• Enable/Disable Offline Editing. 
• Set-up the Comm Port. 
• Set the Set-up Passcode 
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________________________________________________________ 
4.3.1 ENABLE OFFLINE EDITING 
 
This function allows the user to perform “Offline” editing on the 
currently loaded set-up data file.  This allows the user the ability to 
make any necessary changes to the set-up parameters while not online 
with the processor.   
 
If offline editing is not enabled, the user is only able to view the set-
up parameters and shift data.  When the program is first invoked, the 
default setting is offline editing disabled.  The user will need to 
specifically select “Enable Offline Editing” from the edit menu (or 
press function key F2) to enable/disable this feature. 
 
 
________________________________________________________ 
4.3.2 SETUP COMM PORT 
 
This function allows the user to specify the serial communications 
port and baud rate to talk to the M4500.  The programming port of the 
M4500 is set to 9600 baud.   
 

 
 
Once selected, a dialog box requesting the user to select a “Comm 
Port” and “Baud Rate” will be displayed.  The default setting is 
COM1 at 9600 baud.  The option to select the 19200 baud rate is to 
allow the user to communicate with the processor via the S4516 serial 
communications board. 
 
In most cases the user will only need to specify the communications 
port and leave the baud rate at 9600.  If communication problems 
occur, make sure there is a secure connection from the PC to the PLC.  
Then check the Comm port.  In most cases the user will only need to 
select a new Comm port.  If communication problems persist there 
may be another program causing a conflict with the port.  Check the 
port configuration from the “Settings” folder. 
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________________________________________________________ 
4.3.3 EDIT SET-UP PASSCODE 
 
The edit “Set-up Passcode” is an “Online” function only.  This allows 
the user the ability to directly change the value of the “Set-up 
Passcode”.  The passcode is not included as part of the setup data file. 
 
Once selected, an input box is displayed, allowing the user to view 
the current “Passcode” setting and to change the value if necessary.  If 
the passcode is set to zero, passcode entry is disabled.  The operator 
can press the Set-up key on the Keypad/Display and simply press the 
<ENTER> key to gain access to the set-up parameters without having 
to enter a zero.  
 
If the value of the passcode is a value between 1 and 65,000, 
“Passcode Entry” is enabled.  This requires the operator to enter in the 
“Correct” passcode to gain access to the set-up parameters. 
 
Note:  Passcode entry is only in effect when the “Set-up Enable” 
selector switch is in the “Disable” position. 
 
If an invalid value is entered, the passcode value will not be reset and 
a message box notifying the user of the error is displayed. 
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________________________________________________________ 
4.4 THE VIEW MENU 
 
The “View” menu allows the user to perform the following functions: 
 
• View the “Target Board Interface” 
• View “Online” Data 
• View “Offline” Data 
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________________________________________________________ 
4.4.1 TARGET BOARD INTERFACE 
 
This function allows the user to view fault codes, S3000 network 
communication error codes and review the current “Ident” and 
“Revision” of the application program.  This is accessed by the 
“View” menu, by selecting “Target Board Interface”. 
 

 
 
Once invoked, the set-up program will prompt the user to select a 
program to compare with the one existing in the processor.  Whether 
a program is selected or the user cancels, the setup program will 
attempt to communicate with the M4500.  If unsuccessful, a warning 
message will be displayed, prompting the user to either “Retry” or 
“Cancel” the operation.  If the operation is canceled and 
communication with the processor cannot be established the system 
will be placed in an “Offline” mode, however the “Target Board 
Interface” window will still be displayed. 
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________________________________________________________ 
4.4.2 VIEW ONLINE DATA 
 
This function allows the user to place the set-up program in an 
“Online” mode with the processor.  This is accessed by the “View” 
menu, by selecting “Online Data” or by simply pressing the “F3” 
function key. 
 
Note:  The program can be toggled between “Offline” and “Online” 
by simply double clicking on the “Online” or “Offline” panel 
displayed in the status bar at the bottom of the window. 
 
Once invoked, the set-up program will attempt to open the Comm 
port and communicate with the M4500.  If the set-up program is 
unsuccessful, a warning message will be displayed prompting the user 
to either “Retry” or “Cancel” the operation.  If the operation is 
canceled and communication with the processor cannot be established 
the system will be placed in an “Offline” edit mode. 
 
Note:  Anytime while the set-up program is “Online” with the 
processor and communication is interrupted, a warning message will 
be displayed, prompting the user to either “Retry” or “Cancel” the 
operation. 
 
 
________________________________________________________ 
4.4.3 VIEW OFFLINE DATA 
 
This function allows the user to place the set-up program in an 
“Offline” mode.  This is accessed by the “View” menu, by selecting 
“Offline Data” or by simply pressing the “F4” function key.  This 
allows the user to perform “Offline” editing.  All values displayed in 
“Offline” edit mode reflect the actual values contained in the 
currently loaded set-up data file. 
 
Note:  The program can be toggled between “Online” and “Offline” 
by simply double clicking on the “Online” or “Offline” panel 
displayed in the status bar at the bottom of the window. 
 
Once invoked, the set-up program will close the Comm port and cease 
communication with the M4500. 
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________________________________________________________ 
4.5 THE WINDOW MENU 
 
The “Window” menu allows the user to select one of 5 different 
Display/Set-up windows to modify set-up parameters, view shift data 
or receive feedback about the current status of the control system. 
 

 
 
Once a window menu item is selected, a check mark is placed next to 
the selected item and the selected window is displayed with the name 
changed in the title bar of the main window. 
 
Note:  “Read” only variables are displayed in blue with a gray 
background.  Any variables that can be altered by the user are 
displayed in black with a white background.  In most cases, a 
parameter that can be changed by the user will have associated with it 
increment and decrement controls.  The user can either click on the 
desired parameter to adjust and enter in a new value, or use the 
increment or decrement controls to change the value by 1 unit. 
 

 
HSM-WI7 User’s Manual SYSTEMS Electronics Group 

 
- 54 - 



SECTION 4 
HSMWI7 WINDOWS BASED 

SET-UP PROGRAM REFERENCE 
________________________________________________________ 
4.5.1 THE MAIN DISPLAY WINDOW 
 
The “Main Display” window is used to display the general state of the 
control system.  This window is selected from the “Window”. 
 

 
 
The following is a list of the functions of the “Main Display” 
window. 
 
Messages:  The “Messages” display is continuously updated.  It 
displays alarm and status messages specific to the M4500, as well as, 
the current “Online” or “Offline” status of the set-up program.  By 
simply scrolling the display, the user is able to view all active alarm 
and status messages.  If no alarm or status messages are active, a 
default message is displayed. 
 
Machine Speed:  This display is only active while “Online” and 
displays the current speed of the machine in “Strokes Per Minute”. 
 
Position:  This display is only active while “Online” and displays 
the current angular position of the Bodymaker crankshaft. 
 
Good Cans:  This display is the “Current Shift” total number of 
good cans so far into the current shift.   
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Short Cans:  This display is the “Current Shift” total number of 
short can faults that the machine has had so far into the current shift. 
 
Brake Response:  This is the brake response of both the low and 
high speed stops.  The response is the number of degrees it takes the 
press to stop from when the clutch is de-activated for a BDC stop to 
the position that the machine comes to rest. 
 
 
________________________________________________________ 
4.5.2 THE SETUP PARAMETERS WINDOW 
 
The “Set-up Parameters” window is used to view and adjust any of 
the set-up parameters.  This window is selected from the “Window” 
menu. 
 

 
 
This window utilizes a “TAB” control to divide the set-up parameters 
into three categories, similar to that of the Keypad/Display. 
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Brake Wear Compensation:  This section is used to set the brake 
wear compensation parameters in the M4500.  This section contains 
the following selections: 
 
1) Brake Wear Compensation Enable: This prompt is used to 

enable or disable the brake wear compensation. If the 
compensation is to be disabled, deselect the check box. If the 
compensation is to be enabled, select the check box. 

 
 The HSM-WI7 incorporates a brake wear compensation or 

automatic BDC timing feature, which stops the press at “Back 
Dead Center” regardless of the actual braking response of the 
clutch/brake. The stopping compensation is accomplished by 
automatically adjusting the BDC timing signal based on the 
previous stop. Any overrun is detected and a new BDC timing 
signal is computed such that the machine will stop at the desired 
location on the next stop. Two BDC signals are provided: one for 
low speed and one for high speed. Both incorporate the break 
wear compensation feature. The appropriate BDC timing signal 
(low or high) is adjusted based on the speed of the machine when 
the BDC stop was initiated. 

 
2) Desired BDC Stop Position (Low Speed): This is the 

desired stopping location (in degrees) for a BDC stop at low speed 
when the brake wear compensation is enabled. This is typical set 
to 000 degrees (Back Dead Center). 

 
3) Desired BDC Stop Position (High Speed): This is the 

desired stopping location (in degrees) for a BDC stop in high 
speed when the brake wear compensation is enabled. This is 
typical set to 000 degrees (Back Dead Center). 

 
4) Maximum Allowed Stopping Response (degrees): This 

defines what the maximum allowed brake response is before the 
"Brake Response Too Long" alarm is generated. If the actual 
brake response (number of degrees from when the brake is 
activated to the position where the press ends up at rest) when a 
BDC stop is performed is longer than this number, the alarm is 
generated. If the actual brake response is less, the alarm is not 
generated. Set this parameter to the value where the brake 
response is considered too long and service to the brake should be 
performed (typically 270 to 300 degrees). 
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Bodymaker Running Speeds:  This section is used to set the 
bodymaker running speeds in the M4500.  This section contains the 
following selections: 
 
1) Running Bodymaker Low Speed (SPM): This is the speed 

(in strokes per minute), that the bodymaker will run when in low 
speed. 

 
2) Running Bodymaker High Speed (SPM): This is the speed 

(in strokes per minute), that the bodymaker will run when in high 
speed. 

 
 
Trimmer Parameters:  This section is used to set the trimmer 
speed references in the M4500.  This section contains the following 
selections: 
 

 
 
1) Trimmer Maximum Speed (CPM): The "Trimmer Maximum 

Speed" parameter is used to scale the 0-10VDC analog output 
such that when the bodymaker is running at the speed entered in 
"Trimmer Maximum Speed", the analog output will be at 10 volts. 
This is typically set to the running high speed of the Bodymaker 
or slightly higher. 
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2) Trimmer Idle Speed (CPM): This parameter determines the 

speed the trimmer will run at when the bodymaker is stopped (de-
clutched).  

 
 Note: When the bodymaker is running, the trimmer speed 

reference is proportional (as set by the "Trimmer Maximum 
Speed" scaling) to the speed of the bodymaker. This parameter is 
used to provide the speed reference when the bodymaker speed is 
zero. 

 
3) Trimmer High Speed Offset: This parameter is used to 

modulate the speed of the trimmer as a function of cans present at 
the infeed of the trimmer. A high infeed sensor can be added to 
the trimmer infeed such that the trimmer will run at the 
bodymaker running speed plus the "Trimmer High Speed Offset" 
value. This allows the trimmer to speed up when the infeed to the 
trimmer backs-up and slow down once the trimmer runs the cans 
out. 
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________________________________________________________ 
4.5.3 THE MACHINE TIMING WINDOW 
 
The Machine Timing window is used to invoke the PLS programming 
command menus.  From this window, the user can view or adjust the 
following parameters: 
 
• Adjust Timing Channel setpoints. 
• Set the Main Crank resolver offset. 
• Clear or Recall a PLS timing channel. 
• View the current PLS configuration 
• Reset the PLS configuration to default settings. 
 

 
 
In addition, the following parameters are displayed at the bottom of 
this window: 
 
RPM:  This is the current speed in “Revolutions per Minute” of the 
main crank resolver. 
 
Position:  This is the current “Position” in degrees of the main crank 
resolver. 
 
Offset:  This is the current resolver offset (set in degrees). 
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Scale:  This is the scale factor of the resolver or the number of 
divisions in one revolution. 
 
Note:  The General Timing Signal Locations section provides a 
complete description of each timing channel signal. 
 
 
Zeroing the Machine (setting the resolver offset):  To set 
machine zero, perform the following: 
 
1) Connect an RS-232 SYSdev cable from the COM port on the 

computer to the “PROG” port on the M4500.   
 
2) From the “Window” menu, select “Machine Timing”. 
 
3) From the “View” menu, select “Online Data”.  The set-up 

program will attempt to communicate with the processor and 
place the system into an “Online” mode of operation. 

 
4) Observe the “Position” field at the bottom of the window.  Verify 

that as the machine is rotated forward, that the position increases 
linearly from 0 through 359 degrees.  If not, swap the S1 and S3 
leads at the resolver connector on the M4500.  Then, verify that 
the position does indeed increase with forward movement. 

 
5) Position the machine at machine zero (inch the bodymaker to back 

dead center BDC). 
 
6) Auto zero the resolver by entering “0” in the “Resolver Offset” 

field and clicking the “Set Offset” command button.  A message 
box will appear, prompting the user to confirm their choice.  
Select “Yes” to set the resolver offset. 

 
7) The M4500 will calculate the actual offset value required to make 

this the “0” position.  The new offset value will be displayed in 
the “Offset” field and the position will then read zero. 

 

 
HSM-WI7 User’s Manual SYSTEMS Electronics Group 

 
- 61 - 



SECTION 4 
HSMWI7 WINDOWS BASED 
SET-UP PROGRAM REFERENCE 

Adjusting the Timing Channel Setpoints:  To set any of the 
timing signal setpoints, perform the following: 
 
Note:  Any changes made to the timing channel setpoints will be 
saved as part of the setup data file. 
 
1) Connect an RS-232 SYSdev cable from the COM port on the 

computer to the “PROG” port on the M4510.   
 
2) From the “Window” menu, select “Machine Timing”. 
 
3) From the “View” menu, select “Online Data”.  The set-up 

program will attempt to communicate with the processor and 
place the system into an “Online” mode of operation. 

 
4) Set all channels per section 6 – General Timing Signal Locations.  

Setpoints for a particular channel are either entered in the field or 
adjusted by using the increment/decrement controls. 

 
 Note: Only one set-point is used per channel.  
 
5) If a channel needs to be “Recalled” or “Cleared”, enter the desired 

channel number into the “PLS Channel” field.  Click the “Recall 
Channel” command button to recall the setpoints.  Click the 
“Clear Channel” command button the completely clear all 
setpoints for the selected channel. 

  
 Note:  If a channel has been cleared or the “On” and “Off” 

setpoints have the same setting, the set-point will be displayed as 
“*****”. 
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Resetting the PLS Configuration:  As an aid to the user the 
current PLS configuration is displayed in the “PLS Configuration” tab 
of this window.  The PLS configuration should only be reset if a new 
module has been installed.  To reset the PLS configuration, click the 
“Reset PLS Config” command button.  This function only resets the 
PLS configuration to the default settings. 
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________________________________________________________ 
4.5.4 THE SHIFT DATA WINDOW 
 
The “Shift Data” window is used to view the shift data collected by 
the M4500.  This window is selected from the “Window” menu. 
 

 
 
Current Shift Data:  This data is the totals so far into the shift.  
This data is transferred to the "Last shift" at the end of either an 8 or 
12 hour shift or alternatively could be done at label changes such that 
the data collected would be for label runs rather than complete shifts.  
This data can be reset by the user from this section. 
 
Note:  The “Transfer Data” command button is only active while 
“Online”.   
 
1) Total Good Cans: This is the total number of good cans 

produced so far into the current shift.  This is essentially a can 
counter. 

 
2) Total Short Can Faults: This is the total number of short can 

faults that have occurred so far into the current shift. 
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Last Shift Data:  The "Last Shift" data is for the previous 8 or 12 
hour shift, however the shift collection is set-up.  This allows data 
collection and diagnostics to take place automatically over a two shift 
period. 
 
 
________________________________________________________ 
4.5.5 THE I/O STATES WINDOW 
 
The “I/O States” window is provided to display states of the inputs 
and outputs.  The control boards, the states of the timing channels, as 
well as states of the M4500 are shown.  This includes the interrupt 
inputs (IN0 and IN1), the analog I/O and the resolver.  These values 
are displayed as read by the M4500 processor. 
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The DOS based “HSMWI7” set-up program is menu driven program, 
allowing the user to easily view data or alter set-up variables using a 
laptop or personal computer. In addition to setting the set-up 
variables, it can be used to download the application program to the 
module as well as download and up-load the set-up data and save it to 
disk. The set-up variables are used to configure and tune the HSM-
WI7 to match the configuration and performance of the specific 
bodymaker (see section 2.8). 
 
The main menu of the “HSMWI7” set-up program incorporates the 
following menu selections: 
 

 
 
Note:  The “HSMWI7” program is an on-line communications 
program used to interface with the M4500 module. The data 
displayed in the menus and set in the menus is communicated directly 
to the module. Therefore, prior to selecting any of the above 
selections, make sure an RS-232 cable is connected from the COM 
port on the computer running “HSMWI7” to the “PROG” port on the 
HSM-WI7. 
 
The following sections are a complete description of the “HSMWI7” 
selections and menus.  
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________________________________________________________ 
5.1 SET BODYMAKER/TRIMMER SET-UP PARAMETERS 
 
This selection is used to set the various set-up parameters in the 
HSM-WI7. When selected, the “Bodymaker/Trimmer Set-up 
Parameters” menu is invoked.  
 
The “Bodymaker/Trimmer Set-up Parameters” menu contains the 
following selections: 
 

 
 
The following selections set the corresponding parameters: 
 
 
________________________________________________________ 
5.1.1 ENABLE/DISABLE BRAKE WEAR COMPENSATION 
 
Brake Wear Compensation Enable? (0=No, 1=Yes): This 
prompt is used to enable or disable the brake wear compensation. If 
the compensation is to be disabled, enter “0” and press <ENTER>. If 
the compensation is to be enabled, enter “1” and press <ENTER>. 
 
Desired BDC Stop Position (Low Speed): This is the desired 
stopping location (in degrees) for a BDC stop in low speed when the 
brake wear compensation is enabled. This is typical set to 000 degrees 
(Back Dead Center). 

 
HSM-WI7 User’s Manual SYSTEMS Electronics Group 

 
- 68 - 



SECTION 5 
HSMWI7 DOS BASED 

SET-UP PROGRAM REFERENCE 
Desired BDC Stop Position (High Speed): This is the desired 
stopping location (in degrees) for a BDC stop in high speed when the 
brake wear compensation is enabled. This is typical set to 000 degrees 
(Back Dead Center). 
 
 
________________________________________________________ 
5.1.2 MAXIMUM ALLOWED B/M STOPPING RESPONSE 
 
Maximum Allowed Stopping Response (degrees): This 
defines what the maximum allowed brake response is before the 
“Brake Response Too Long” alarm is generated. If the actual brake 
response (number of degrees from when the brake is activated to the 
position where the press ends up at rest) when a BDC stop is 
performed is longer than this number, the alarm is generated. If the 
actual brake response is less, the alarm is not generated. Set this 
parameter to the value where the brake response is considered too 
long and service to the brake should be performed (typically 270 to 
300 degrees). 
 
 
________________________________________________________ 
5.1.3 SET BODYMAKER RUNNING SPEEDS 
 
Running Bodymaker Low Speed (SPM): This is the speed (in 
strokes per minute) that the bodymaker will run when in low speed. 
 
Running Bodymaker High Speed (SPM): This is the speed (in 
strokes per minute) that the bodymaker will run when in high speed. 
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________________________________________________________ 
5.1.4 SET TRIMMER SPEED REFERENCES 
 
Trimmer Maximum Speed (CPM): The “Trimmer Maximum 
Speed” parameter is used to scale the 0-10VDC analog output such 
that when the bodymaker is running at the speed entered in “Trimmer 
Maximum Speed”, the analog output will be at 10 volts. This is 
typically set to the running high speed of the Bodymaker or slightly 
higher. 
 
Trimmer Idle Speed (CPM): This parameter determines the speed 
the trimmer will run at when the bodymaker is stopped (de-clutched).  
 
Note: When the bodymaker is running, the trimmer speed reference 
is proportional (as set by the “Trimmer Maximum Speed” scaling) to 
the speed of the bodymaker. This parameter is used to provide the 
speed reference when the bodymaker speed is zero. 
 
Trimmer High Speed Offset: This parameter is used to modulate 
the speed of the trimmer as a function of cans present at the infeed of 
the trimmer. A high infeed sensor can be added to the trimmer infeed 
such that the trimmer will run at the bodymaker running speed plus 
the “Trimmer High Speed Offset” value. This allows the trimmer to 
speed up when the infeed to the trimmer backs-up and slow down 
once the trimmer runs the cans out. 
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________________________________________________________ 
5.2 SET MACHINE TIMING 
 
The Set Machine Timing selection is used to invoke the PLS 
programming command menus (these are the same menus used in 
SYSdev to program the PLS section of the HSM-WI7). When 
selected, the PLS programming main development menu will be 
invoked using the default “WI7TMG” channel set-point file.  
 

 
 
From this menu, the user can zero the machine (set the resolver 
offset) and adjust the timing signal set-points. The following sections 
describe how to perform these functions, section 6 provides a 
complete description of each timing signal. 
 
Note:  Prior to selecting the Machine Timing selection, make sure the  
RS-232 cable is connected from the COM port on the computer to the 
PROG PORT on the HSM-WI7. 
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________________________________________________________ 
5.2.1 ZEROING THE MACHINE 
 
To set the machine zero (resolver offset) perform the following: 
 
1) Select the “2: Set Machine Timing” selection from the HSM-WI7 

set-up program main menu. 
 
2) Select “1: Online Channel Setpoint Programming” from the Main 

Development menu. 
 

 
 
3) Select “F9: POS/RPM” and observe the “POS:” field. Verify that 

as the machine is rotated forward (either inching or barred) that 
the position increases linearly from 0 through 359. If not, swap 
the S1and S3 leads of the resolver at the HSM-WI7 resolver 
connector. Then verify that the position then indeed does increase 
with forward movement. Press <ESC> to exit the “POS/RPM” 
update. 

 
4) Position the machine at back dead center. 
 
5) Auto zero the resolver by selecting “F10: Set Offset”. Enter “0” in 

the offset field and press <ENTER>. The HSM-WI7 will calculate 
the actual offset value required to make this the 000 position and 
will display this number in the offset field. The position will now 
read 0. 
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6) Exit back to the PLS Main Development menu by pressing 

<ESC>. Exit back to the “HSMWI7” set-up main menu by 
pressing <ESC>again. 

 
 
________________________________________________________ 
5.2.2 ADJUSTING THE TIMING CHANNEL SET-POINTS 
 
To set or alter any of the timing signal set-points, perform the 
following: 
 
1) Select the “2: Set Machine Timing” selection from the HSM-WI7 

set-up program main menu. 
 
2) Select “1: Online Channel Setpoint Programming” from the Main 

Development menu. 
 
3) Set all channels per section 6. Set-points are entered for a 

particular channel simply by typing in the set-point in the form 
XXX-YYY<ENTER> in the first set-point of the given channel  

 
Note: Up to 50 set-points may be entered for any channel. 
However, for the bodymaker only one set-point is used per 
channel and this should be entered in the number 1 set-point. 
 
The XXX is the location the set-point will turn “on” while YYY is 
the location where the set-point will turn “off”. Use the PgUp, 
PgDn, F1:Next Chan, or F2: Prev Chan keys to select the desired 
channel for programming. 

 
4) Once all channels are programmed, press <ESC> to exit back to 

the PLS Main Development Menu. Press <ESC> again to exit 
back to the “HSMWI7” set-up main menu. The new channels will 
be saved both in the module and in the “WI7TMG” file on the 
hard drive. 
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________________________________________________________ 
5.3 SHIFT DATA/BRAKE RESPONSE 
 
This selection is used to view the Current Shift data, Last Shift data, 
and the Low and High Speed Brake Responses. When selected, the 
“Shift Data/Brake Response” menu is invoked.   
 
The following data is displayed in the “Shift Data/Brake Response” 
menu: 
 

 
 
Current Shift - Total Good Cans: This is the total number of 
good cans produced so far into the current shift. This is essentially a 
can counter. 
 
Current Shift - Total Short Can Faults: This is the total number 
of short can faults that have occurred so far into the current shift. 
 
Last Shift: The "Last Shift" data is identical to the current shift data 
except it is for the previous 8 or 12 hour shift or previous label run, 
how ever the shift collection is set-up. This allows data collection and 
diagnostics to take place automatically over a two shift period 
 
Note:  The current shift data is transferred to the “Last shift” data 
when the end of shift input transfers from a “0” to a “1”. This data 
cannot be reset either from this menu or by the operator, only at the 
end of shift transition. 
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Lo Speed Brake Response (degrees): This is the number of 
degrees from the when the clutch was de-activated (at the BDC (Lo) 
timing) to where the bodymaker crankshaft came to rest when a BDC 
stop was performed at Low speed. This can be used to determine the 
general condition of the brake and whether servicing of the brake is 
required. 
 
Hi Speed Brake Response (degrees): This is the number of 
degrees from the when the clutch was de-activated (at the BDC (hi) 
timing) to where the bodymaker crankshaft came to rest when a BDC 
stop was performed at high speed. This can be used to determine the 
general condition of the brake and whether servicing of the brake is 
required. 
 
Note:  The brake response of the brake for both high and low speeds 
is updated after each BDC stop. 
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________________________________________________________ 
5.4 DOWNLOAD PROGRAM TO MODULE 
 
This selection is used to download the HSMWI7 application program 
to the HSM-WI7 module. This should only be performed when 
replacing the module or when the program has been changed. To 
download the program, perform the following: 
 
Note:  Program download cannot be performed while the bodymaker 
is running. All outputs on the HSM-WI7 are turned “off” and no 
program execution is performed. The bodymaker should therefore be 
stopped before the download takes place. 
 
1) Connect the RS-232 cable from the COM port on the computer to 

the “PROG” port on the HSM-WI7. 
 
2) Select “4: Download Program to Module” from the Main Menu. 

The current program ident, revision, and checksum for both the 
program on disk and already loaded in the module will be 
displayed. A prompt will be displayed asking to continue or abort. 
To continue, press any key except the <ESC> key. To abort, press 
the <ESC> key. If a prompt stating that the “HSMWI7” file could 
not be opened is displayed, then the “HSMWI7” application 
program is not installed in the current directory. 

 
3) Once program download is initiated, HSM-WI7 program 

execution will cease, the current address being downloaded will 
be displayed, and the “RUN” LED on the module will flash 
continuously. 

 
4) Once the download is complete, the “RUN” LED on the module 

will illuminate solid and program execution in the HSM-WI7 will 
resume. Press any key to return back to the “HSMWI7” main 
menu. 

 
5) This selection can also be used to verify the program ident, 

revision, and checksum without downloading the program. 
Perform steps 1 thru 3 above but instead of initiating the 
download in step 3, simply press the <ESC> key to abort the 
download once the ident, revision, and checksum have been 
displayed. 
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________________________________________________________ 
5.5 DOWNLOAD SET-UP DATA TO MODULE 
 
This selection is used to download the previously uploaded (saved) 
set-up variables to the HSM-WI7 module. This should only be 
performed when replacing the module.  
 
Note:  The set-up data consists of the bodymaker and trimmer set-up 
parameters. Timing channel set-points are not stored as part of the set-
up data, these are stored in the “WI7TMG” file. To download the set-
up data, perform the following: 
 
1) Connect the RS-232 cable from the COM port on the computer to 

the “PROG” port on the HSM-WI7. 
 
2) Select “5: Download Set-up data to Module”. A prompt will be 

displayed asking to continue or abort. To continue, press any key 
except the <ESC> key. To abort, press the <ESC> key. 

 
3) Once data download is initiated, the current address being 

downloaded will be displayed.  
 

Note: Program execution is not ceased therefore data download 
can be performed while the machine is running. 

 
4) Once download is complete, press any key to return to the main 

menu. 
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________________________________________________________ 
5.6 UPLOAD (SAVE) SET-UP DATA FROM MODULE 
 
This selection is used to save the set-up variables from the HSM-WI7 
module to the hard drive (current directory selected). This should be 
performed anytime any of the set-up variables have been changed.  
 
Note:  When the set-up variables are changed, they are changed 
directly in the module, not on the file in the computer. By uploading 
(saving) the set-up variables to disk, they can be downloaded to the 
module in the event the module must be replaced. 
 
The set-up data consists of the bodymaker and trimmer set-up 
parameters. Timing channel set-points are not stored as part of the set-
up data, these are stored in the “WI7TMG” file. To upload the set-up 
data, perform the following: 
 
1) Connect the RS-232 cable from the COM port on the computer to 

the “PROG” port on the HSM-WI7. 
 
2) Select “6: Upload (Save) Set-up data from Module”. A prompt 

will be displayed asking to continue or abort. To continue, press 
any key except the <ESC> key. To abort, press the <ESC> key. 

 
3) Once data upload is initiated, the current address being uploaded 

will be displayed.  
 

Note: Program execution is not ceased therefore data upload can 
be performed while the machine is running. 

 
4) Once upload is complete, press any key to return to the main 

menu. 
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The following is a general description of the timing signals and the  
locations they should be set at: 
 
CH00: BDC (High) Timing: This signal is used to de-activate the 

clutch for a BDC stop at high speed.  
 
 Note: The leading edge is used to de-activate the clutch, thus 

the width of the signal is not critical (generally set 20 degrees 
wide).  

 
 When the brake wear compensation is enabled, this signal is 

adjusted automatically by the HSM-WI7. If the brake wear 
compensation is disabled, this signal must be set manually. In 
this case it should be set such that the press stops at back 
dead center for a BDC stop at high speed. 

 
CH01: BDC (Low) Timing: Same as the BDC (High) timing 

(CH00) except used when the machine is running in low 
speed. 

 
CH02: Short Can Timing: This signal is used to verify the length 

of the can and verify that the can is good. The short can 
sensor must “see” can the entire time this signal is “on” to 
prevent a short can alarm. This signal is generally set in the 
range of “on” at 150 to 160  and “off” at 170 to 175”. 

 
CH03: Sensor Check Timing: This signal is used to verify that 

the short can sensor does not fail “on”. The short can sensor 
must be “off” the entire time this signal is “on” in order to 
prevent a “die sensor fail” alarm. This signal is generally 
programmed to be “on” just prior to the punch emerging from 
the die set on the forward stroke (typical “on” at 110 and 
“off” at 130). 
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CH04: Cupfeed Timing: This signal is used to activate the 
cupfeed “on” when enabled and back “off” when disabled. 
The leading edge of this signal is used to activate the 
solenoid “on” while the trailing edge is used to activate it 
“off”. The “on” set-point is generally set such that when the 
cupfeed is opened, the cup will drop onto the high part of the 
rotary cam. The “off” set-point is generally set such that the 
cupfeed will close such that the cup is caught with-out 
causing damage to the cup that is retained. This signal is 
generally set “on” at 230 to 250 and “off” at 280 to 320. 

 
CH05: Air Strip (Low) Timing: This signal is used to activate the 

air strip solenoid when the machine is running in low speed.  
The air strip is “on” for the entire window that CH05 is “on” 
while the machine is running with the cupfeed open. This 
signal is generally set “on” about 140 degrees and then set 
“off” at about 200. 

 
CH06: Air Strip (High) Timing: Same as the Air Strip (Low) 

timing (CH05) except used when the machine is running in 
high speed. This is generally set “on” about 120 degrees and 
then “off” at about 190. 

 
CH07: PLC Timing: This is a general purpose timing signal 

provided as an output which can be input to the host PLC and 
used for whatever purpose desired by the host PLC. This 
channel is not used by the HSM-WI7. 

 
CH10: Motion Timing: This is a pulse train set “on” for 30 degrees 

and then set “off” for 30 degrees through-out the entire 
channel. 
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SECTION 7 
RECOMMENDED SPARE 

PARTS  
The Following are recommended spares for the HSM-WI7. These 
parts are available through Systems Engineering Assoc. Inc. 
 
 
 Quantity Part Number Description 
 

1ea. HSM-WI7 Standun Bodymaker High Speed 
Logic Module 
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